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Chapter 8   

Utility Toolbars  
 

 In this Section:  
  
• Alignment Toolbar introduced with Order, Spacing, and Alignment of 
components 
• Designer Toolbar introduced and its relation with Preferences explained 
• How to read the Color Palette Toolbar and its designations 
• Font Editor briefly introduced and explained 
• Use of the Line Editor Toolbar is explained 
• Functions of the Project Toolbar are introduced 
• Zoom Toolbar functions covered 
 

Tools are Tools  
Even though the toolbars are called toolbars, there are two distinct types, relating to the function 
performed. There are Utility Toolbars and Component Toolbars. 

A tool is typically used to modify an item already on the Page, usually a component. A component 
is an object placed on the Page, like a Region, Shape, Line, or Barcode (for more information 
regarding components, see the Components Overview chapter). 

This chapter will cover the Utility Toolbars, which contains tools (Color, Alignment, etc.) used to 
modify components. Utility Toolbars include the Alignment Toolbar, the Color Palette Toolbar, the 
Fill Toolbar, the Font Editor Toolbar, the Line Editor Toolbar, the Project Toolbar, and the Zoom 
Toolbar. 

Using Tools  
The Utility Toolbars act on components and the Page Designer. Either a component or the Page 
has to be selected prior to using the toolbar. For example, to change the fill color of a Square, 
select the Square and then click on the required color. 

By right clicking on a component, a popup menu will appear giving access to other options that 
can change the component. These options are also available from the toolbars; the popup menu 
just gives faster, easier access. 

Alignment Toolbar  
 

 

The Alignment Toolbar is used to align, order, and move a group of components on the Page. It is 
important to note that some of the Alignment options only make sense when more than one 
component is selected. 

The first step is to select the components that need to be aligned. To select multiple items, hold 
the shift key down and click the mouse on each object that needs to be aligned. 
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For most alignment options, the first component selected is what determines the alignment 
position. For example, when choosing Align Left, all selected components will be left aligned to 
the position of the first selected component. A red line on the icon designates the actual 
alignment. 

 

 

The Alignment Toolbar is divi ded into four sections by separators. The first two sections control 
horizontal and vertical alignment options. Both allow components to align on the edges, centers, 
or to be spaced equally. 

 

 

 

 

The Order Alignment determines the Z order (depth along the Z axis) 
between components. Order Alignment does not require more than one 

component to be selected. To establish the Z order of a component, select the component and 
right-click the mouse button to display the popup menu. From the Order submenu choose one of 
the four options: Move Forward, Move Behind, Bring to Front or Send to Back. The figure to the 
right shows a Rectangle with an Ellipse imposed in front of it. To move the Ellipse to the back of 
the Rectangle, right-click the Ellipse (by right-clicking on a component previously unselected, it 
will select it and bring up the popup menu) and choose Send to Back from the Order submenu. 

There are an additional four buttons on the Alignment Toolbar, Tap Tools, which allows small 
incremented movements of a component (or group of components). To move selected 
component(s), click on the corresponding arrow to move the component(s) towards the desired 
direction. 

 

 

Designer Toolbar  
The Designer Toolbar is used to control the 
Preferences for the Page. All of the Designer 
Toolbar items toggle. By clicking on a button, 
the property of the component associated with 
the button will change status. To change it back to the previous state, click on the button once 
more. The top toolbar shows what the buttons look like when they are not pressed (toggle status 
off) and the bottom toolbar is the resulting toolbar when the buttons have been depressed (toggle 
status on). 
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Color Palette  
 

 

 

The Color Palette is the tool used to change a color of a selected object such as a Line, Text 
component, or the fill area in one of the shapes (Circle, Ellipse, Rectangle, or Square). Color 
palettes are composed of several sections that show custom, standard and current colors. The 
left button on the right side displays the currently selected Primary, while the right button shows 
current Secondary color. All other color squares serve as the Color Palette from which you can 
select. 

To change the color of an object, select the object and either left or right-click on the Color 
Palette. A left-click selects the Foreground Color (Primary) while the right-click selects the 
Background Color (Secondary). 

When a Primary Color is selected, a "1" will be placed on the corresponding color indicator on the 
palette. Similarly, a "2" will be placed indicating the Secondary Color. 

To change the color of an object (like a Rectangle), first select it and then click on the desired 
color with the left mouse button. To change the Fill Color, click on the desired color with the right 
mouse button. 

Double-clicking on the user defined Custom Colors (right side) or on the Foreground and 
Background Color boxes will open a more detailed color control window called the Color Editor. 
From the Color Editor, custom colors can be created by adjusting the red, green and blue values, 

 
 

"Activate Grid" controls whether the grid lines are visible or not on the Page Layout 

 
 

"Snap To Grid" controls whether the objects on the Page 'snap'. Snap means that the 
component will only move and resize according to where the Grid 
Lines are present 

 
 

"Grid On Top" determines whether the Grid Lines are always on top of the 
components or not (i.e. are not hidden when components are placed 
on the Page Designer) 

 
 

"Always Show 
Band Headers" 

controls the displaying of band headers 

 
 

"Show Rulers" toggles the appearance of guide rulers in the environment 

 
 

"Show Waste 
Area" 

displays the space between the Page boundary and the end of the 
Page Setup Boundary  

 
 

"Edit 
Preferences" 

will bring up the Preferences dialog 
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as well as the saturation of the color by increasing or decreasing the color percentage. 

 

 

 

To create and save a new color, use one of the Custom Colors to enter into the Color Editor, then 
click on the New Color button and choose the desired color from the Color dialog box. By entering 
the Color Editor from one of the Custom Color boxes, the new color will be saved. If the Color 
Editor is entered from either the Primary or Secondary Color boxes, the color will only be saved in 
those boxes until a new color is chosen (either by clicking on the right or left mouse button or by 
the creation of another color). 

It is important to note that the actual exhibited colors are dependent on the display settings of the 
computer. If there are issues with colored objects when transferring reports from one system to 
another, check the display color settings. A 256-color setting only uses 256 colors for display, 
where as a True Color setting uses millions of colors. Thus, for example, if a Report is created on 
a system set at True Color, and then viewed on another system set at 256 Colors, some objects 
may appear grainy or to have the wrong color shadings. 

Font Editor  
 

 

 

The Font Editor can be used to change the type, size, attributes and alignment of any text 
component in the report. Its aspect and functioning is very similar to Font Toolbars found in the 
most commonly used Word Processors. 

To change the Font settings of a Text component, first select the component. The font type can 
be adjusted by choosing a font from the drop-down list. Similarly the size can be changed by 
clicking on one of the available sizes for the font in question. The Bold, Italic and Underline 
buttons are toggled depending on the state of the text. To set the font to Bold, just click on the 
Text component and then press the Bold button. The button will then remain depressed until it is 
clicked on again or until focus is moved to a different text object that does not have the Bold set. 
The Italics and Underline button work in much the same way. There are three alignment buttons 
that indicate the alignment of the text within the area it is contained, and the options are left, 
centered, and right-justified. All text-based components have a property called Font that appears 
in the Property Panel when the component is selected. Any changes made to the Font, are 
reflected both in the font toolbar and in the Font property. 

NOTE: It is important to note that if a font is chosen on the development machine and this font is 
not available on the deployment or any other machine, Rave will assign the next most similar font 
to the one chosen. 

Line Editor  
Use the Line Editor to modify the style and thickness of a line or the border of a shape. The Line 
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Editor Toolbar has several selections to choose from including line styles (solid or combinations 
of dots and dashes). 

To change the style of a line, first select the line or shape, and then choose the point size of the 
line as Hairline. Finally, choose the style of the line. 

To change the thickness of a solid line, first select the line or shape. Then choose the point size 
desired. 

Line style only (dashes, dots, etc) applies if the line thickness is hairline. If a line is set to a certain 
style (like dashes) and then given a thickness other than hairline, the line style will be changed to 
a solid line. 

 

 

 

Project Toolbar  
 

 

The Project Toolbar provides the basic functionalities for a Project. It gives a quick easy way to 
complete the common tasks associated with managing a Project. All options available on the 
Project Toolbar are accessible through the main Project menu in Rave. 

The first three icons deal with managing projects: 
 

 
 

"New Project" creates a new Project 

 

 
 

"Open Project" opens a previously saved Project 

 

 
 

"Save Project" saves the current Project 
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The next three icons deal with creating specific aspects of the current project: 
 

 
 

"New Report" will create a new Report that will be contained in 
the same Project file (.rav file). Rave can have 
more than one Report per Project file 

 

 
 

"New Global Page" creates a new Global Page 

 

 
 

"New Data View" allows the creation of DataViews that are 
associated to the current Project. Please see 
Connecting to Data chapter more information 
about DataViews. 

 

The last two icons deal with the currently selected Report. 
 

 
 

"New Page" creates a new Page in current Report 

 

 
 

"Execute Report" execute (or print) the current Report 

 

Zoom Toolbar  
The Zoom Toolbar allows the user to Zoom In to view the details of a document better or Zoom 
Out to view the overall Page uniformity. Within the Zoom Toolbar, there are several ways to zoom 
into and out from the details of the document. 

 

 

To Zoom by Percentage, the Zoom Factor drop menu has many preset 
percentage factors to Zoom in and Zoom out. Simply choose the desired Zoom 
Percentage. If one of the presets is not adequate the you can specify a 

percentage by typing the desired percentage into the edit box next to the zoom factor drop menu. 

Another method to get a customized size is to click on the Zoom Tool (magnifying glass). 
Drag the tool over the specified area that needs to be magnified. 

For a simple manual Zoom In and Zoom Out, click on the magnifying glasses with the "+" 
and "-" sign. Nothing will need to be selected to use this tool. Each click is set to a 
specified incremental amount that is set in the Preference settings. To get to the settings 

area, go to Preferences in the Edit Menu. In the Edit Menu, select the Designer Tab. In the area 
called "Zoom Increment", increase or decrease the percentage by using the up/down arrows to 
increase the percentage or simply type in the percentage. 

To zoom in on selected items, use the magnifying glass with the dashed box. First select 
the desired item(s), and then click on this tool. The viewable area will frame all item(s) 
selected. 
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. 

Use the "Page Width" button to zoom to the full width of the currently selected Page. 

Use the "Whole Page" button to Zoom to the full page size of the current page. 

Exercise: Aligning Components  
This exercise will demonstrate how to align components. The example images have six 
numbered lines of text. 
1. To begin, drop several Text components onto a Page. In this example, the components 

have been number labeled 
  

 
 

2. Lines two, four, and five will be aligned. Lines three and six will also be aligned 
  

 
 

3. Select Line Two. This will be the primary component that the rest of the components 
alignments will be based on 

  

 
 

4. While holding the shift key, select lines Four and Five to be aligned with Line Two. Notice 
the light gray border that appears with pips 
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5. Once all components have been selected, choose Align Left Edges on the Alignment 
Toolbar. Notice that all three components left edges have been aligned 

  

 
 

6. To further show how the alignment works, click on the Align Right Edges button on the 
Alignment Toolbar 

  

 
 

7. Go through the rest of the Alignment tools to see how they function 
8. Let's align the second set of text. First, select the primary component to base the 

alignment on, in this case Line Three 
  

 
 

9. Then select the other component(s) that will be aligned, by holding the shift key and 
clicking on Line Six 
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10. Then click on the Align Left Edges to align the components. 
  

 
 

 

Exercise: Ordering Components  
Ordering refers to the ordering of components along the Z-axis. This is the axis that comes out of 
the Page. 

To order components along the Z-Axis, the order buttons on the Alignment Toolbar must be used. 
1. To begin, there must first be components on page. These can be any components. For 

this example we will use a Rectangle, Oval, and Circle 
  

 
 

2. First select a component to move. In this example, the rectangle will be moved behind 
the Oval. Notice in the Project Tree the placement of the Rectangle component 
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3. Once the rectangle is selected click on the Move Behind button on the Alignment 
Toolbar. Notice that after clicking the button once the rectangle has not moved behind 
anything yet, but on the Project Tree the rectangle has moved up the tree 

  

 
 

4. Try clicking on the Move Behind button one more time. The rectangle will move up the 
Project Tree and the Rectangle on the page will move behind the Ellipse 

  

 
 

5. For the second component, select the circle and click the Move Behind button. The 
Circle component will move up the tree and move behind the Ellipse 
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6. Click on the Move Behind button once more and the Circle will move up the tree one 
more time and remain behind the Ellipse 

  

 
 

 

Exercise: Snapping to the grid  
Snapping to Grid refers to the moving and resizing of components according to where the grid 
lines on the page are present. 
1. To begin, bring up the Preferences Dialog box by selecting Preferences from the Edit 

menu 
2. Select the Defaults tab and look for the area labeled Grid Spacing 
3. In Grid Spacing, change to .02 units. Then look for the area called Draw Grid Every 
4. In Draw Grid Every, enter 1 line (type or use the up and down arrow). Draw Grid Every 1 

(that's what we chose) line, will show every Grid line made. If this were changed to Draw 
Grid Every 3 lines, then for every third line the Grid would be marked in the Visual 
Designer 

5. Next go to the Project menu and choose New. This will create a new Project, as well as 
a new Report Page, that is based on the preferences that were just changed in the 
previous steps. Remember the Grid lines serve only as page guides for designing 
reports; they do not show up in any report executions 

6. Go to the Designer Toolbar and click on the Snap To Grid 
7. Now that the Report Page is created, drop a rectangle on the page 
8. Now move the rectangle around and notice that the rectangle only moves according to 

where the lines are located. Try using the tap buttons. Notice that the component doesn't 
seem to move until the tap button moves are on one of the grid lines 

9. Now to go the Designer Toolbar and click on the Snap To Grid button to turn the feature 
off 

10. Move the rectangle and notice that the rectangle will move to positions between the grid 
lines 
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Exercise: Changing Line Size and Color of a Rectangle  
1. Create a new Report Page 
2. Drop a rectangle component on the Page 
3. Look at the Color Toolbar. Notice the color blocks marked 1 and 2, you can review 

Primary and Secondary Designations in this chapter 
4. To make the color change more notable in this example we will increase the boundary 

lines of the Rectangle. Bring up the Lines Toolbar. Select the Rectangle. Then in the first 
Lines Toolbar drop-down box, choose a larger border size. In this example, the 
borderline has been increased from hairline to 2.25 points. 

5. Left-click on any color in the Color Toolbar. In this example the color Olive was selected. 
Notice that the border has changed to Olive. Also notice that the Primary Color has 
changed. The Primary Color is the color of the border. 

6. Right-click on any color. In this example the color Blue was selected. Notice that the fill 
inside the Rectangle has changed to Blue. Also notice that the Secondary Color has 
changed. The Secondary Color is the color of the inside of the Rectangle 

 

Exercise: Changing Fonts  
1. 

 
 

Create a new Report Page. 

2. 

 
 

Drop four Text components on the Page. 

 
3. Select a component, and then view the Font Toolbar. 
  

 
 

4. On drop-down menu displaying the Font Name, click on the down arrow and choose a 
desired font. 

5. Go to the next component and repeat Steps 3 and 4. Do this for all remaining Text 
components. 

6. Also, try using the font-sizing drop-down menu. As well as the Bold, Italic, and Underline 
options 

7. The last three buttons to the far right deal with placing the font as left-justified, centered, 
and right-justified. Practice using these options to get the desired formatting effect. 
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Chapter 9   

Standard Components  
 

 In this Section:  
  
• Explains the difference between a Text component and a Memo component 
• How to use a Section and its relationship to the Project Tree 
• How to insert BMP and META files 
 

Overview  
 

 

The Standard Toolbar contains seven components: Text, Memo, Section, Bitmap, Metafile, 
FontMaster, and PageNumInit. Several of the Standard Components are used most frequently 
when designing reports. This chapter will provide a detailed explanation of the first five. The 
remaining two (FontMaster and PageNumInit) are covered in the Advanced Components chapter. 

Access to the Standard Toolbar is achieved in the same way as with other toolbars. If it is not 
present on the screen, it can be displayed by selecting it from the Toolbar submenu in the Tools 
menu. 

Text  
The Text component is useful for displaying a single line of text on the report. It acts 
basically like a label that can contain simple text (not data). When placed on the report, 
the Text box is surrounded with a box that indicates its boundaries. This can only be 

seen while the text component is selected (represented by the pips). 

The component can be used for labels, such as for figure or graphical titles, floating text, form 
titles, and in general just about anything that is denoted by a single line of text. 

When the component is selected, the length of the text can be adjusted by resizing it using the 
pips. Note however that the height of the text is self-adjusting and does not require further 
intervention by the user. 

Like any other text-based component, there is a Font property that can be used to change the 
font type, size and style. The color can be set using the Color property. The actual text of the 
component, which is seen on the screen, is denoted by the Text property. 

There is an additional property called Rotation, which can be used to rotate the text by a specified 
number of degrees. The effect can only be seen at runtime. 

Memo  
Memo components are similar to Text components. However the most noticeable 
difference is that Memos can contain multiple lines of text. Memos can be used on forms 
for areas of explanation, and for titles or comments that are longer than one line. 

Similar to the Text component, the border around the Memo can only be seen when the 
component is selected. When setting the Font of the Memo, all the lines of text in the Memo will 
have the same font. It is not possible to set different fonts for certain parts of the text. 
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To change the text in the Memo, go to the Property Panel and use the Text property. The Text 
property will show "(Memo)" and an ellipse button, which are three dots. Click on the ellipse 
button. This will open up the Memo Editor. Text can be entered into the Memo Editor. 

One of the main problems with using multi-line text components is that the text might overlap in 
height on to other components on the Report. To prevent this, set the ExpandParent property to 
True. This will expand the Parent of the Memo component to properly accommodate the Memo 
component. 

Once the text is entered, the Memo box can be resized. The text within the Memo box will be 
repositioned accordingly. If there appears to be text missing from the Memo box, after it has been 
entered into the Memo Editor, resize the box to allow all text to be visible. 

Section  
The Section component is used to group components. This provides advantages, such 
as allowing all the components that form part of the Section to be moved together with 
one mouse-click, as opposed to moving each component individually or trying to select 

all components before moving. 

To use the Section Component, first press the Section Component button and then use the 
cursor/arrow to make a selection on the Page. When the selection is completed, there will be a 
box marked by dashes with green pips. Within this area, place any components that need to be 
grouped together. 

The Project Tree becomes very helpful when dealing with the Section component. From an 
expanded Tee, it is easy to see what components are in each Section. Each Section and 
component can also be easily selected simply by clicking on the appropriate object in the Tree. 

If an object is ever placed beyond the viewable section area, the Project Tree can be used to 
select the object. Once the object is selected, the object's border pips can be seen and thus its 
location. The object can then be deleted or moved (hint: to move use the tap buttons in the 
Alignment toolbar). 

As seen from the relationship with the Project Tree and the Section component, there is a need to 
understand Parent-Child relationships between components. To read more on these types of 
relation ships see the Project Tree Panel chapter, it contains a section on Parent-Child 
Relationships. The Section component also becomes very important when mirroring. Mirroring 
will be covered in the Managing Report Projects chapter. For now, just know that once the 
Section component is mastered, using this with mirroring will become extremely helpful. 

Bitmap and Meta File  
The Bitmap and Metafile components enable images to be placed in a report. Bitmap 
supports image files with the extension ".bmp", and MetaFile supports image files with 
the extensions ".wmf" and ".emf". 

To insert an image, first click on either the BMP or the META buttons on the Standard 
components toolbar, then click any location on the Page. A placeholder box with an X will 

appear on the Page, and the box may be bigger than what the image will be. This can be fixed 
after the image is loaded. 

Once the BMP or META placeholder is on the Page, go to the Property Panel and to the FileLink 
property. Click on the ellipse, the button with three dots. 

This will bring up the Open Dialog. Find the image file, select the file, and click Open. 

Once the image is loaded, resize the placeholder pips on the image border. 

Exercise: Text vs Memo  
The decision to use either a Text or a Memo component is quite easy. If there is only a single line 
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of text to be placed on a Page, use the Text component. Use the Memo component when there is 
more than one line of text to be used. 

To place and change a text component: 
1. 

 
 

Click on the Text component located on the Standard Toolbar. The component 
button will change colors to designate activation. 

 
2. Click once on the Page. The Text component will appear on the Page. Also notice that a 

new component will be added to the Project Tree under the Page that it was placed. 
3. Go to the Property Panel and in the Name property change the name of the Text 

component. 
4. In the Text property, change the default text to the desired text to be displayed on the 

Page. 
5. View the Property Panel and the Page. Notice that the Project Tree has the Text 

component changed to the name entered in the Name property. Also, on the Page the 
component has the desired text typed into the Text property. 

 

To place and change a memo component: 
1. 

 
 

Click on the Memo Component located on the Standard Toolbar. The component 
button will change colors to designate activation. 

 
2. Click once on the Page. The Memo component will appear on the Page. Also notice a 

new Memo component will be added to the Project Tree under the Page that it was 
placed. 

3. Go to the Property Panel and in the Name property change the name of the Memo 
component. This will change the name of the Memo component in the Project Tree 
under the Page that the component was placed on. 

4. In the Property Panel, go to the Text property. Click on the ellipse, the button with three 
dots (…). 

5. The Memo Editor will appear. In the Memo Editor, type in the text that needs to be 
placed on the Page. The Memo will recognize returns made with the Enter key. 
Remember though, that the Memo will be subject to the size of the Memo box on the 
Page. 

6. When the text has been entered, click OK. 
7. When done, the Memo component can be moved or resized by using the green pips. 

 

Exercise: Section  
To create and use a Section Component: 
1. 

 
 

Click on the Section component. The component button will change colors to 
designate activation. 

 
2. Click on the Page, and a dotted box will appear with pips at its boundaries. This is the 

Section component. 
3. In the Project Tree, notice that the Section component was added under the Page it was 

placed. 
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placed. 
4. While the Section component is selected, place any other component into the Section. 

When done, notice that the placed components will now be under the section in the 
Project Tree. 

5. Once components are placed into a Section, all the components can be moved together. 
To try this out, place the cursor on the border of the Section, click and hold, then drag 
the Section around the Page. 

6. The Section can also be resized. Click and hold any of the pips and then move the 
cursor in the desired direction, the Section box will resize. 

7. When done, click anywhere on the Page to deselect the Section component. The 
Section is an invisible border displayed by a dashed rectangle, but it will not be printed. 

 

Exercise: Placing and Resizing Bitmaps  
1. To complete this exercise, find a Bitmap (BMP) image on your computer. The image will 

have a ".bmp" extension at the end of the file name. Remember the location of this 
image. 

 
2. 

 
 

Create a New Report Page. Do this by selecting New Report Page from the 
Project menu. 

3. 

 
 

On the Standard Toolbar, click on the BMP button. 

 
4. Then click once on the Page to drop the Bitmap component. The green pips will appear 

around the edges to indicate that it is selected. 
5. While the Bitmap component is still selected, go to the Property Panel. Look for a 

property called FileLink Property. There will be three dots, called an ellipse button, to the 
right of it. Click on the ellipse button. 

6. Using the Look in drop-down menu and selecting the image in the box below. Once The 
Open Bitmap dialog will appear. Find your Bitmap image on your computer by the file is 
selected, click Open. 

7. The image will appear on the Page with green pips around the image. 
8. Now look at the Property Panel and look at the property MatchSide. This property deals 

with the proportions of the image when it is resized using the pips. 
9. Click on each of the MatchSide choices and move the image around a bit to see the 

effects of the choices. 
10. This is msBoth. The pips on all sides allow the resizing of all pictures in all directions. 
11. This is msHeight. This helps in resizing the pips according to height, while still keeping 

the image proportional. Using the top and bottom pips will resize the image. 
12. This is msInside. This allows proportional resizing, but all resizing is done with in the 

limits of the pip. The image doesn't leave the borders of the pips. 
13. This is msWidth. This does proportional resizing according to the left and right pips of the 

image. 
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Chapter 10   

Drawing Components  
 

 In this Section:  
  
• Explains how to place a Drawing Component. 
• Describes all the Drawing Components. 
• Discusses Pixels vs. Points. 
 

Drawing Component Basics  
All the Rave graphical components are created using the Drawing Components. 

 

 

To use any of the Drawing Components, click on the desired component in the Drawing Toolbar 
then click once on the Page or other container component. This will create the object on the Page 
or other container component. Once the component object is created it can be resized to the 
desired dimensions by dragging the pips around the selected object border. Also, to color and 
stylize the components, use the Fills (where applicable), Lines, and Colors Toolbars. For more 
information on these toolbars, see the Utility Toolbars chapter. 

The Property Panels of each drawing components are almost identical. The Name property may 
be the only thing that distinguishes one Property Panel from another. 

The Line component can be used to draw a line in any direction. Angled lines may be 
used to draw lines between rotated lines of text. They may also be used as diagonal 
lines inside a square giving the effect of a box with an "X" in it. 

Line styles may be set for the line; however, you should be aware that when setting line styles it 
is best to stick with a line width of one. Line styles are often ignored when the line width is any 
greater than this. 

The HLine component may be used to draw horizontal lines. One of the common uses 
for the horizontal line is to drop one into a DataBand and set it so that it is positioned at 
the very bottom of the Band. It is also set to stretch the whole length of the Band. When 

the Band is printed, the line creates the effect of having the Band information printed on lined 
paper. 

The VLine component may be used to draw vertical lines. One of the more common uses 
for the vertical line is to drop one into a DataBand and set it so that it is positioned in 
between various data fields that are being printed. The height of the line is set to the 

same height of the Band. When the Band is printed, the vertical line gives the effect of having the 
information printed in nice neat columns. 

The Rectangle component may be used to draw rectangles. One of the more common 
uses for the Rectangle is to drop one into a DataBand and set it so that it is sized to 
completely fill the band. It is then moved to the back so that other components dropped 

on the Band will print over the top of the rectangle. When the Report is printed, this gives the 
effect of having a nice block around the rows of printed data. 
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The Square component may be used to draw squares. A common usage of this 
component is showing checked or unchecked boxes. The checked boxes are created 
with the use of the Square component and the Line component, or perhaps by simply by 
placing an "X" in the Square. This is useful when trying to illustrate items that have been 

selected. 

The Ellipse component can be used to draw an ellipse or oval shape, more simply 
defined as a flattened circle. If you want to change the shape of the Ellipse, you can do 
this by clicking on the Ellipse with the left mouse button. Then move the mouse over one 

of the pips that will appear. Press the left mouse button again, and while continuing to hold the 
mouse button down, move the mouse until the Ellipse is the desired size and shape. You can 
also resize the Ellipse by setting the properties directly using the Property Panel. Simply enter 
new values for the Width or Height properties. 

The Circle component can be used to draw a circle with a constant radius. If you want to 
change the size of the Circle, you can do this by clicking on the Circle with the left mouse 
button. Then move the mouse over one of the pips that will appear. Press the left mouse 

button again, and while continuing to hold the mouse button down, move the mouse until the 
Circle is the desired size. You can also resize the Circle by setting the properties directly using 
the property panel. Simply enter new values for the Width or Height properties. 

Pixels vs Points  
For every Drawing Component, the Property Panel has two properties that deal with Line Width. 
The LineWidth property is a numeric value for the width of the line, which depends on the 
LineWidthType. The LineWidthType property actually lets the user determine which type of value 
the line will be set. The Types available are Points and Pixels. 

When creating drawing objects, it is important to determine in what format the audience will be 
seeing the Report. This is important when determining if Points or Pixels will be used for the line 
width type. 

Points are a unit of print, not a unit of screen space. Points are the unit of measurement used 
most commonly with paper design. It has meaning in the paper medium. Unfortunately, points are 
meaningless on the screen and the web. Due to platform and resolution differences, something 
like 14pt can mean many things. What it does not mean is a specific unit of screen size. Pixels, 
on the other hand, are defined unit. A pixel is always equal to a pixel. 

Points and Pixels Preferences are dependent upon what the designer wishes the user to 
experience. To let the user adjust the text size at will or let the user's internet browser preference 
determine the size, specify points. If the design depends on a rigid text size or if the text size 
must be consistent across platforms, specify Pixels. 

To print the thinnest possible line, use a Line Width of 1 pixel. For thicker lines, values in points 
should be used for consistency across printers with different resolutions. 

Exercise: Creating Drawing Components  
1. First create a new Page. Use New Report Page from the File menu, or use the icon on 

the Project Toolbar. 
2. Now, go to the Drawing Toolbar. Pull it down from the Tab area, so that we can 

concentrate on it here. 

 
3. Click on the Square, notice 

that it's button changes to a 
depressed button and 
changes color. Click your 
cursor on the Page and 
hold down the left mouse 
button while dragging out 
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button while dragging out 
the shape of the square. 

 
 

4. Next, click on the Ellipse. 
Click on the Page and hold 
down the left mouse button 
while dragging out the 
shape of the Ellipse. The 
Ellipse outline will look like 
a Rectangle, but once the 
mouse button is let go the 
ellipse shape will appear. 

 

 
5. Then, click on the 

Horizontal Line and draw 
them on the Page. Do this 
for several lines. Make 
them different lengths. 

 

 
6. One thing to notice for 

every shape, when the 
mouse button is released 
pips outline the shapes. 

 



RAVE Reference Manual 

Page 68 

pips outline the shapes. 
When all shapes are 
selected the pips appear. 

 

 

Exercise: Alignment  
1. First create a new Page. Use New Report Page from the File menu, or use the icon on 

the Project Toolbar. 
2. From the Drawing Toolbar, click on the horizontal line button then click on the Page. The 

line will appear as the default line size on the Page. The clicking on the button and 
clicking on the Page is what we call dropping an object on the Page. 

 
3. Select the horizontal line by clicking on it.  

 
 

4. Go to the Property Panel and change the default value 
of the line by typing 2.5 into the Width property edit box. 

 

5. Drop down at least 10 additional horizontal lines about 
an inch below the first one. 

 

 
 

6. Drop down one more horizontal line about 3 inches 
below the first group of lines. 

 

7. Select the top horizontal line by clicking on it. The green 
pips will appear at the ends of the line when selected. 

 

8. While the first line is still selected, hold down the Shift 
key and start clicking on the other lines. This will add all 
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key and start clicking on the other lines. This will add all 
the other horizontal lines to the selection. To select the 
remaining lines faster, while the first line is selected and 
any other additional lines are also selected, keep 
holding the Shift key and click on the Page and drag the 
resulting box over the rest of the lines. 

 
 

9. In the Alignment toolbar, click on Equate Widths 
alignment button. This will make all the lines the same 
width as the first selected line. 

 

 
 

10. On the Alignment Toolbar, click on Align Left Edges 
button. This will align all the lines to the left edge of the 
first selected line. 

 

 
 

11. Next, on the Alignment toolbar, click on Space Equally 
Vertically. This will space the lines equally away from 
each other on the vertical axis. For more exercises on 
Alignment, see the Utility Toolbars. Chapter. 
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